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Dear customer,

We are happy that you have chosen AntiViral Toolkit Pro (AVP), the 

world’s best anti-virus defense, for protecting your computer against computer 

viruses. Kaspersky Lab’s best anti-virus experts are working hard to provide 

you with this best-of-breed anti-virus solution and to face your strictest 

conditions. By choosing AVP you choose unbeatable anti-virus protection.

Kaspersky Lab always cares about their customers, providing them with an 

easy-to-use and high performance products with strong and comprehensive 

functionality. The highest possible level of anti-virus protection, highly 

intelligent heuristic code analyzer, support for the most wide-spread mail 

formats, virus detection inside archived and compressed files, powerful 

management tools – these are the main advantages you get with AVP. We 

provide you with the ultimate customer service: round the clock technical 

support, extensive information support, personal attention and immediate 

response to a new virus attack.

We appreciate the trust you have placed in our anti-virus products. We 

hope you will find our work effective and useful.

Kaspersky Lab. Team
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1. Antiviral Toolkit Pro Platinum edition for 
Windows

1.1. Main Functions and Features
AVP Platinum is an antiviral package for multi-user licenses. It can 

operate under several OS.
 DOS;
 Windows 95/98;
 Windows NT Workstation.

It contains several components.
 AVP Monitor for Windows 95/98/NT Workstation;
 AVP Scanner for Windows 95/98/NT Workstation;
 AVP Scanner for DOS;
 AVP Control Center.

AVP Monitor is a program that stays constantly in the memory and 
tests opening documents on the local computer. Program has abilities to
set up types of checking objects and actions on the infected files. 
Therefore you can set up AVP Monitor for supplying the best safety and 
for preventing your computer from contamination.

AVP Scanner for Windows 95/98/NT Workstation is a Windows 
application for checking local and network files on the instructions of the 
user. Having this program you can test the system periodically. As for 
settings it will provide you full abilities for elimination virus attack.

AVP Scanner for DOS is 32-th bit application with graphic interface 
for scanning files on the instructions of the user. AVP. This program is 
recommended for using in situations when OS loading is impossible. 
Write AVP Scanner on system diskette and antiviral databases on 
another diskette. In case of virus infection you should load computer 
from system diskette and start scanner program. In addition you can use
this program to provide antiviral safety of the computers of the old 
models.

AVP Control Center is a program scheduler that provides you to 
control all components of AVP Gold package. By means of this program
you can set schedule of the files checking, add/remove components, 
update antiviral databases and output the report about operations.

Package could contain AVP Network Control Center that allow user 
to control programs of AVP Platinum by means of network.

Users of AVP Platinum are provided with round-the-clock supporting 
by telephone and e-mail in English and in Russian.
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“Kaspersky Lab.” company recommends you to apply antiviral 
package AVP Platinum for enterprises and organizations having local 
networks.

1.2. Distribution Kit
1.2.1. Distribution Kit

The AVP distribution kit contains the following components.
 License Agreement;

 Sealed envelope containing AVP distribution diskettes;

 User Guide;

 Register card.
 Before you unseal the envelope make sure to thoroughly review 

License Agreement.

1.2.2. License agreement
License Agreement is a legal agreement between you (either an 

individual or a single entity) and the manufacturer (Kaspersky Lab Ltd.) 
describing the terms on which you may employ the purchased by you 
antivirus product. Make sure to peruse License Agreement! If you do not
agree to the terms of LA, Kaspersky Lab is not willing to license the 
software product to you and you should return the unused product to 
your AVP dealer for a full refund, but make sure the distribution diskette 
envelope to be sealed. 

If you unseal the envelope it means that you agreed to all the LA 
terms.

1.2.3. Registration Card
To register please fill a detachable coupon of the register card (your 

full name, phone, e-mail address) and mail it to the dealer (the address 
is specified on your AVP kit box) you purchased the kit from.

You may also e-mail your register information to sales@avp.ru. But 
in this event make sure to specify your message subject as 
«Registration». If your mail/e-mail address or phone number changed 
please notify the entity you have mailed the register coupon to.

If registered you will become the AVP registered user and will be 
provided with the product support and the antivirus base updates for the
period of your subscription. Besides Kaspersky Lab provides AVP 
registered users with information on the company new products.
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1.3. Information in the Book
This book contains information on how to install and manage AVP, 
explains basic concepts of the software product and the way it can be 
applied, recommends on how to manage and change settings. This 
book doesn’t describe installation procedure and operation concepts of 
the package.
1.3.1. Product Support

All the registered users are provided with the product support for the 
period of subscription. 

If you register and purchase the subscription you will be provided 
with the following services for the period of your subscription:
 antivirus base weekly update;

 new versions provision;

 phone, e-mail or in-office advising on matters related to your AVP package;

 provision of information on the AVP line new products and on the 
worldwide newborn computer viruses.
For more information on Kaspersky Lab services refer to your 

README.TXT file

9



2. Installing AVP

2.1. Installation procedure
Start Windows 95/98/NT Workstation. Then insert CD-ROM with 

AntiViral Toolkit Pro (AVP). After that start setup.exe with the help of 
“Explorer”, item “Run” in menu “Start” or item “Add/remove programs” in 
control panel and follow the instructions of Setup Wizard. During 
installation process you’re are able to press buttons “Next>”, “<Back” 
and “Cancel”. To go to next step of installation press “Next>” button, to 
return to the previous step press “<Back” button and for canceling of 
installation process press “Cancel” button and button “Exit” in the 
appeared window.

Make several steps.

Setup process

Window “Welcome”

Step 1. After starting of 
setup file you may see 
window “Select language”. 
This window is used for 
selection of language that you
want to see as the language 
of interface. Select language 
and press “OK” button. After 
that all dialog windows will be
outputted in the selected 
language. Then you may see 
window “Setup”. It means that
Setup Wizard starts working. 
Wait a moment while Setup 
Wizard makes necessary 
actions and outputs window 
“Welcome”. 

This window contains invitation to user and description of 
recommended actions related with installation process. Read it 
attentively and then installation program start searching of installed 
components.

1 0



Window “Installation mode”

Step 2. If AntiViral Toolkit 
Pro was already installed on 
your computer then program 
output window “Installation 
mode” where you may start 
updating of previous version 
of package or install program 
once again i.e. to continue 
operating in “Upgrade” mode 
or in “Clean” one. If AVP 
wasn’t installed then go to 
step 3. 

To upgrade previous version means to remove old components and 
to install new components (if number of current build is higher than 
number of build of installed package) or to add components (if number 
of installed build is the same as number of installing build). By the way 
during “Upgrade” mode installation will be proceed in the same 
directories with the same settings. “Clean” installation means that AVP 
package will be installed in new catalogues with new settings. Therefore
if you select “Clean” installation than go to step 3 else go to step 7.

Window “Software license agreement”

Step 3. Here installation 
program output window 
where you will see text of 
license agreement. Read it 
attentively and if you are 
agree with it press “Yes” 
button otherwise press “No” 
and break installation. By the 
way text of license agreement
is written on the cover of CD-
ROM that is included into 
standard package.

Step 4. Enter information 
about user in the window 
“User Information”. You may 
see in the fields “Name” and 
“Company” information from 
Windows registry by default.

Step 5. You should select 
catalogue where you want to 
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Window “User Information” install AntiViral Toolkit Pro. 
By default you may see path 
“C:\Program Files\Antiviral 
Toolkit Pro” in the filed 
“Destination folder”. To select
another catalogue press 
“Browse” and select another 
path.

Step 6. In the window 
“Select program folder” enter 
name of the folder that you 
want to see in “Start” menu in
the item “Programs”. Name is
AntiViral Toolkit Pro by 
default. 

Step 7. Here you must 
select type of installation. For 
doing it select one of the 
several types:
1. Typical.

2. Compact.

3. Custom
If you select “Typical” then

all components of AntiViral 
Toolkit Pro will be installed. If 
you select “Compact” then 
only necessary components 
will be installed such as AVP 
Monitor, antiviral bases and 
Update program. In case of 
“Custom” you may select 
some components from the 
list. So if you select “Custom” 
then go to step 8 else go to 
step 9.

Window “Choose destination folder”

Window “Select program folder”

Window “Setting Type”
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Window “Select Components”

Step 8. Here you must 
select installing components 
from the list. In the window 
you may change directory for 
installation. To do it press 
“Browse” button and select 
new path. At the bottom of 
the window information about 
memory state of target disk is
outputted.

For getting information about memory state of another disk press 
button “Disk Space” and in the appeared window select new disk.

Window “User account for AVP Control Centre”

Step 9. If you have 
Windows 95/98 on your 
computer then go to step 10 
and if you have Window NT 
Workstation than you will 
window “User account for 
AVP Control Centre”. In the 
window you must specify user
name that account will be 
used for starting AVP Control 
Center as system service, his
password and his domain. By
default you will see current 
user name and domain.

If you are mistaken when you enter these parameters than system 
service couldn’t start and if you make these parameters empty then 
Control Center will start as system service under local account but you 
won’t send alerts from your computer i.e. you won’t have one important 
feature of Control Center.

Window “Administration password”

Step 10. You have to enter
password for remote control 
in the fields. Remote control 
is control of components of 
AVP package by means of 
Network Control Center 
through network.

Step 11. If you have OS 
Windows 95/98 on your 
computer then go to step 12. 
If you have Windows NT 
Workstation then you will see 

1 3



Window “Installation of AVP Monitor”

window “Installation of AVP 
Monitor”. Here you must 
specify if you want Monitor to 
be executed as application or 
as system service. Monitor 
may start and operate as 
application after logon 
process but user must be 
administrator and Monitor 
might work as system service
i.e. it will start after logon 
procedure and operate for all 
users even user isn’t 
administrator.

To start Monitor as system service enable item “System service” 
otherwise disable it.

Window “Start coping files”

Step 12. In the window 
“Start coping files” you may 
see all your settings. You 
may see them, check them 
and correct them. To make 
corrections press button 
“<Back” until you reach target
window. One click to “<Back” 
means to go to the previous 
step of installation. To go to 
the next step press “Next>”. 
Then installation process will 
be continued. To interrupt it 
press “Cancel” button and 
“Exit” button.

Window “Setup needs the next disk”

Step 13. If you have no 
key file at the source directory
then at the end of the 
installation process 
installation program will 
output window “Setup needs 
the next disk”. Here you must 
specify path to key file or 
press button “Browse” and 
select necessary directory. 
Key file is a file with key 
extension. It is your own key 
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where you may find all 
auxiliary information 
necessary for operating of 
AVP.

It contains several data.
1. Address, company name and phone of distributor of current 

version.
2. Support information.
3. Date of release.
4. Name and number of license.
5. Table of functionality of different components.
6. Period of availability of the license.

If you haven’t this file in common folder of AVP then program will 
operate as demo version so it won't have some general features such 
as curing files, checking of network drives, getting updates etc.

Window “Select AVP key file”

Step 14. By clicking left 
button select necessary key 
file. Moving cursor through 
the list you may see 
information about highlighted 
key file at the bottom of the 
window. If no key file is found 
then list will empty.

 Step 15. If you have 
Windows 95/98 on your 
computer then installation 
program will offer to you to 
write some strings into 
autoexec.bat.

These strings provide you starting AVP Scanner each time after 
loading OS. You may also save these strings in autoexec.avp or don’t 
make changes.
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Window “Setup complete”

Step 16. In the window 
“Setup Complete” select one 
of the type of finishing: “Yes I 
must restart my computer 
now” or “No I will restart my 
computer later”. To complete 
setup correctly you must 
restart your computer. 

Step 17. If you selected 
item “No I will restart my 
computer later” on the 
previous step then you will 
see window that offers to you 
to read file Readme.txt.

This file contains information about product and contact information 
of distributors. To read this file enable corresponding item and press 
button “Finish”. Remember that for correct operating of AVP you must 
restart your computer.

Notes.
 If you have one of the previous build on your computer then before 

step 12 (before coping files) Setup Wizard outputs window and offers
to you to remove previous build. For correct operating you must 
remove previous all components of previous version. Press “OK” 
button and you will see window “AVP Uninstaller”. Select 
components for removing (to select all components press button 
“Select all”) and press “OK” button. After that uninstallation 
program start operating.

 If you had the same build on your computer and you’re in “Clean 
installation” mode then before coping Setup Wizard removes all 
installed components automatically.

 Remember! If you make installation of AVP under Windows 95/98 
then steps 9,11 (input of account and starting Monitor as system 
service) are dropped but step 15 (recording strings to autoexec.bat) is
added.

 If you make custom installation under Windows NT Workstation 
and don’t install AVP Control Center then step 9 (input of account) 
is dropped.

 If you make custom installation under Windows NT Workstation 
and don’t install AVP Monitor then step 11 (starting Monitor as 
system service) is dropped.

 You may also install AVP under Windows 2000 but you have to 
remember that it’s test version of operating system so any changes of
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kernel might corrupt functionality of AVP. Setup Wizard give you 
notice about it.
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3. Running AVP Scanner

3.1. Getting Started. Basics
3.1.1. Starting AVP with Extra Switches

AVP can be started the ways similar to the ones employed by the 
Windows 95/98 applications.

To start the antivirus a user should execute the AVP32.EXE file.
To do it the easiest way use the Windows 95/98 Start menu. Point to 

Programs, to AntiViral Toolkit Pro and then point and click AVP 
Scanner. By default during the AVP installation program places AVP in 
the AntiViral Toolkit Pro group, but only if You didn’t appoint some other 
group.

The AVP Desktop shortcut also can be created (If during the 
installation You enabled the corresponding check box the shortcut icon 
should be on Your Desktop). If double-clicked the shortcut icon will start 
AVP immediately.

Besides AVP provides a user with ability to employ the program 
extra switches. It’s convenient to use the switches while starting AVP 
from a command line. You may also specify the AVP extra switches in 
the AVP icon command line. When double-clicked the icon will start 
AVP in some special mode appointed by the switches.

The AVP switch start command line is similar to the following:
AVP32.EXE [/P=profile_name] [/S] [/W] [/N] [/Q] [/D] 

[/@[!]=file_name] [file_name] [directory_name]
Where:

 the /P=profile_name enables a user to start AVP with settings 
specified in the profile_name profile (For more information on the 
profile development see chapter 3.4.1);

 the /S switch automatically starts scanning operation right after AVP
is loaded;

 the /W switch checks the Options sheet Report file check box to 
insure the report development and the report will be developed even
if in the appointed profile this option is disabled;

 the /N switch after AVP is started reduces the AVP main box to an 
icon;

 the /Q switch closes the AVP main window and swaps the program 
out of memory after the scanning operation is finished;

 the /@[!]=file_name switch sets AVP for the immediate after-start 
scanning of the files specified in the file_name file. File_name 
means a name of a text file (ASCII format) containing names of the 
files You want to be scanned. Each line of the file contains only one 
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full-path file name. The “!” character if specified in the switch (i.e. 
/@!=file_name) deletes the file_name file after the scanning is 
finished. If the switch is used without the “!” character (i.e. 
/@=file_name) this file wouldn’t be deleted;

 the /D switch forbids AVP to be started on that day when the data 
volumes were already viruschecked by the antivirus and the 
operation was a successful one (i.e. the scanning was not aborted 
and no viruses were detected).

 if the «/» character is not specified at the beginning of a command 
substring, the substring will be recognized as a file or a directory 
name (file_name, directory_name) (Do not use the “*” and “?” 
symbols in the names). In that case AVP right after started will be 
adjusted according to the settings specified in the file with the PRF 
extension or the Default.prf file or the profile appointed by the 
corresponding switch and will scan these files for viruses. Example:

"C:\AVP\Avp32.exe" С:\CONFIG.SYS D:\EXCHANGE.

Note: If some file or directory name is a long one containing space 
characters the full-path name of this file or directory should be 
concluded in quotation marks. Example:

"C:\Program Files\AVP\Avp32.exe" /S "C:\My documents"
The switches can be employed both together (A space character 

separates one switch from another.) and apart.
AVP with the extra switches can be started the following way: Press 

the Start button and click Run, then in the Run dialog box command line
specify the full-path AVP32.EXE file and the desired switches. Example:

"C:\Program Files\AntiViral Toolkit Pro\Avp32.exe" /P= 
My_Settings.prf /S /N /Q

If You want AVP to be started with some extra switches You also can
modify the AVP Desktop shortcut command line. To modify the 
command line click Your mouse right button on the shortcut icon and in 
the appeared menu select Properties. The Properties:AVP32 tab box 
will appear on Your screen. Press the Shortcut tab and add the desired 
switches to the full-path file name in the Target text field (Figure 5.1). 
Example:

"C:\Program Files\AntiViral Toolkit Pro\Avp32.exe" /P= 
My_Settings.prf /S
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Figure 5.1. The Windows 95/98/NT standard Properties dialog 
box

In that case when the shortcut icon clicked AVP will be started with 
settings specified in the My_Settings.prf file and the scanning operation 
will begin right after the start.

If the AVP icon is added to the StartUp folder AVP will be 
automatically started when You start Windows.

3.1.2. The Return Codes
When AVP being started from the command line after the scanning

operation is finished following return codes may appear on Your screen:
0 - no viruses detected;
1 – the scanning operation is not completed;
2 - objects containing a modified or damaged virus body detected;
3 – the virus suspected objects  detected;
4 – the AVP-familiar virus detected;
5 - all the detected viruses deleted;
7 – the AVPW.EXE file is damaged;
10 – the AVP internal error.

3.1.3. The Ways to Manage the AVP Scanner Options
You can use both Your mouse and the keyboard to manage AVP. To

enable some desired option (tab) of the antivirus click Your mouse left 
button on it or press the <Alt> key together with a key of the character 
underlined in the option name (tab name).
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The arrow keys may be used to move between the menu options 
(tabs).

To select an option in the AVP tab sheet click the mouse left button 
on it or use the arrow keys or press the key of the character underlined 
in the option name.

If You want to reduce the AVP window to the icon on Your taskbar 
press the <Alt> or <Esc> key or click Your mouse left button on the 
screen out of the window area.

General shortcut keys:

 <Home> - moves cursor to the beginning of the being edited field.
 <End> - moves cursor to the end of the being edited field.
 <Spacebar> - enables and disables options; presses buttons.
 <Tab> - highlights the menu next option.
 <Shift+Tab> - highlights the menu previous element.
 <Alt+Tab> - enables to switch between running applications.
 <Alt+Spacebar> - opens system menu.
 <Alt+F4> - closes the running application.

3.1.4. Few Words on How to Start and Run AVP Scanner
After started AVP downloads antivirus databases and performs self-

viruscheck (The AVP32.EXE and AVPW.EXE files are checked for 
viruses). If the start was a successful one (i.e. AVP is not infected) in the
bottom line of the antivirus main window You will see the following 
information: Antivirus bases loaded. XXXXX viruses.(Where XXXXX is a
number of the program-familiar viruses.)

Note! If  the AVP32.EXE file is infected by some virus AVP when
started will display the Disinfect dialog box. If You have a virus-free the
AVP  distribution  copy  we  recommend  You  to  delete  the  infected
program from Your system and replace it with the “healthy” one. If by
any reasons You cannot act this way select the Disinfect command in
the Disinfect dialog box and press OK. In this case AVP will disinfect
itself, offer You to restart the program and close the AVP main window.

2 1



Figure 5.2. The AVP main window

The program main window (Figure 5.2) contains a menu bar (File, 
Scan, Tools, Help), five tabs (Location, Objects, Actions, Options, 
Statistics), the Scan Now button (After the scanning operation is 
started the Scan Now button will be replaced with the Stop one) and 
the Object/Result status/log window. When loaded AVP always 
displays the Location tab sheet.

To begin a scanning operation enable the desired options in all the 
tab sheets press the Scan Now button or select the Scan now command
in the menu bar Scan menu. AVP will scan all the specified in the 
Location tab objects. During the operation the Tracking check box will 
appear in the main window right side area. The option provides a user 
with ability to observe the progression of the files being scanned 
enabling the Object/Result status/log window auto-scrolling mode.

If while scanning You want to abort the operation press the Stop 
button or select the Stop command in the menu bar Scan menu.

To shut down the program You must select the Exit command in the 
menu bar File menu or click, as they usually do it in Windows, the Close
button in the upper-right corner of the window.

3.2. Viruschecking and Deleting the Viruses
To start the AVP scanning operation You have to make some 

adjustments, i.e. specify the objects You want to be viruschecked, the 
ways to treat the object if infected, scanning extra modes and etc. The 
adjustments should be made according to the particular task You want 
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to be performed by AVP. For example if You want to perform a usual 
preventive viruscheck the scanning extra modes may be disabled. But if 
You suspect Your computer to be infected by a virus the scanning extra 
modes should be enabled.

To make it more easy-to-use You may save the settings in profiles, 
i.e. special files with the PRF extension containing kits of settings for 
various AVP tasks. So later You do not have to adjust AVP again since 
You will be able to start the program with options set according to the 
selected profile.

To begin the adjustment mark the drives and folders You want to be 
scanned in the Location tab sheet (Figure 5.2). To do this double-click 
the desired object or highlight it and press the Spacebar key. To 
promptly mark a desired drive in the Location sheet You may just check 
the corresponding check box (Local Hard Drives and/or Network Drives 
and/or Floppy Drives). For example if You checked the Local Hard Drive
check box all the local drives of Your computer will be marked.

If You want to add some other folder to the Location list press the 
Add Folder button. The Open dialog box  containing Your computer 
drives and folders tree will appear on Your screen. In the box You 
should highlight the folder You want to add to the Location list and press
OK.

In the Objects tab sheet check the objects You want to be scanned 
(Memory and/or Sectors and/or Files and/or Packed Files and/or 
Archives).

If all the objects in the Objects sheet are unchecked and You 
pressed the Scan Now button AVP will display the following message: 
“Nothing to scan. You should select Files and/or Sectors in page 
Objects” (Figure 5.3). In that case press OK and check the Object 
sheet objects You want to be scanned.

Figure 5.3 Message prompting a user to specify the objects to be 
scanned

The file masks to be scanned should be specified in the File mask 
option buttons list. To be sure that Your computer is free from viruses 
viruscheck all the files in the computer. To do it use Your mouse or the 
cursor managing keys to mark the All files option button in the File mask
option buttons list.
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While selecting the way the infected object to be treated in the 
Actions tab sheet we recommend You to mark the Display Disinfect 
option button. In this case if while scanning AVP will detect some 
infected object the Disinfect dialog  box will appear on the screen for 
You to appoint the way this object will be treated.

If You check the Copy to Infected/Suspicious folder check boxes the 
infected and suspicious objects if detected will be copied to the 
corresponding folders. It can be useful if You didn’t back up the files 
before they were infected.

Attention! 
Be careful with infected objects and their copies! If these files are the

executable ones do not execute them.
The Options tab provides a user with ability to enable/disable extra 

viruschecking (Warnings and/or Code Analyzer and/or Redundant scan)
and reporting modes (Show clean objects in the log and/or Show pack 
info in the log). A report on the AVP operation can be saved in the report
file. The report file name should be specified in the corresponding text 
field (On default the file name is Report.txt).

If some infected objects are detected try to disinfect them. To our 
regret not all the infected objects can be recovered as some viruses 
damage file data in the irreversible way. In this case the unrecoverable 
objects should be deleted. 

If AVP will notify You on some virus-suspected files and/or sectors 
we recommend You to refer to Your system administrator or to the AVP 
Help Desk department  for assistant. If You are able to spot and copy 
these objects the best You can do is to send them to Kaspersky Lab 
where they will be studied.

3.3. The Tabs
3.3.1. The Location Tab Sheet/Specifying the Drives and Folders to
be Scanned

The Location tab sheet (Figure 5.4) contains a list of drives (Floppy, 
Local) and folders that if marked can be viruschecked by AVP.

You can mark/unmark the desired scanning path using Your mouse 
(double-click on the desired location name) or the keyboard (use the 
cursor managing keys to highlight the location name and the Spacebar 
key to mark/unmark it).
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Figure 5.4. The Location tab sheet
The easiest way to appoint the drive groups (or all the drives) to be 

scanned is to check the following check boxes in the Location tab:
 L  ocal Hard Drives – all the local hard drives will be marked;
 Floppy Drives – all the available floppy drives will be marked.

To scan a CD You have to mark the CD-ROM drive by Your mouse 
or keyboard. The program is not equipped with the check box 
corresponding to CD-ROM drives.

To add some folder to the Location list (scan list) press the Add 
Folder button. The Open dialog box  containing Your computer drives 
and folders tree will appear on the screen. Select the folder You want to 
be added to the list and press OK.

Figure 5.5. Adding a folder to the Location drives/folders scan list
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To remove a folder from the Location list You should highlight it (click
the mouse left button on the folder You want to highlight) and press the 
<Delete> key.

If You do not want some appointed in the list folder to be scanned 
there is no need to remove it from the list. To disable (unmark) the folder
just double-click the mouse left button on it. It’s very convenient since if 
You saved this group of settings in a profile. “The File Menu”) next time 
You start AVP and want to scan the folder You wouldn’t have to add it 
again to the list.

There is another easy and quick way to mark/unmark the groups of 
drives and/or folders You want to be scanned and to start their 
viruscheck. First highlight the desired drives and/or folders (It may be 
done the standard for Windows way: move Your mouse with left button 
pressed to highlight a part of the list covering all the desired drives 
and/or files, then free the button).. If now You press the mouse right 
button on the highlighted area a command menu (Figure) containing the
following commands will appear on Your screen:

Figure 5.6. The selection managing menu
Mark selection – the highlighted drives and/or folders will be marked

(ticks);
Unmark selection – all the highlighted marked drives and/or folders 

will be unmarked (no ticks);
Scan selection – AVP will scan only the highlighted drives/folders 

regardless of weather they are marked or unmarked;
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3.3.2. The Objects Tab Sheet/Specifying the Objects to be Scanned
The Objects tab sheet (Figure) lists objects ( memory, sectors, files, 

packed files, archives) and file masks that may be appointed for 
scanning (The AVP extra scanning modes can be enabled in the 
Options tab sheet).

In the Objects sheet can be checked/unchecked the following check 
boxes:

Memory – enables/disables AVP to scan memory (including High 
Memory Area ) for viruses;

Sectors – enables/disables AVP to scan system sectors for viruses;
Files – enables/disables AVP to scan files (including the System, 

Hidden and ReadOnly ones). The file types to be scanned can be 
specified in the File mask option buttons list (See below);

Packed files - enables/disables the Unpack Engine device capable 
of decompressing the packed by utilities (PKLITE, DIET, LZEXE and 
etc.) files to make them viruscheckable.

Archives - enables/disables the Extract Engine device providing 
AVP with ability to viruscheck the archives (ARJ, ZIP, LHA, RAR).

Figure 5.7. The Objects tab sheet
To enable AVP to scan the e-mail files check the following check 

boxes within the Objects tab sheet:
Mail databases - enables/disables AVP to scan the Microsoft 

Outlook and Microsoft Exchange e-mail databases (files with the PST 
and PAB extensions and also the MS Mail files). AVP viruschecks the 
unpassworded databases as well as the password protected ones.
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Plain Mail formats - enables/disables AVP to viruscheck e-mail files
of the following formats: Eudora Pro & Lite, Pegasus Mail, Netscape 
Navigator Mail, JSMail SMTP/POP3 server.

Attention! If  Unpack  Engine  and/or  Extract  Engine  are/is
enabled the AVP operation rate slows down since it  takes some

time to decompress the files. Enable these Engines if the probability of
some archives or packed files being infected by viruses is high.

Attention! If  the  Mail  databases and  Plain  Mail  formats are
checked the AVP operation rate slows down greatly.

For user convenience the AVP Objects tab sheet is equipped with 
four the File mask option buttons. The following buttons enable a user to
appoint the file masks to be viruschecked by AVP:

Smart - enables AVP to viruscheck the programs, i.e. files with the 
corresponding extensions (BAT, COM, EXE, OV*, SYS, BIN, PRG) and 
files of the format similar to the executable one (e.g. files with the VxD 
and DLL extensions);

Programs - enables AVP to viruscheck the programs, i.e. all the files
with the corresponding extensions (BAT, COM, EXE, OV*, SYS, BIN, 
PRG);

All files - enables AVP to viruscheck the «*.*» mask corresponding 
to any file with any extension;

User defined – commands AVP to viruscheck only the file masks 
defined by a user. If this option button is selected the below text field 
becomes available and a user is enabled to type in the desired masks 
separated by commas.

For daily viruschecks we recommend You to check the Memory, 
Sectors and Files check boxes and select the Smart option button. If 
You suspect Your computer to be infected by some virus select the All 
files option button and enable all the check boxes to scan all the objects.

3.3.3. The Actions Tab Sheet/ Defining the Way the Infected and/or
Suspicious Objects (if detected) will be Treated.

The Actions tab sheet provides a user with ability to define the way 
the infected and/or suspicious objects if detected by the scanner will be 
treated.
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Figure 5.8. The Actions tab sheet
The sheet contains four option buttons and two check boxes (Figure 

5.8).
To appoint the desired way to treat the infected/suspicious object 

click Your mouse left button on one of the following option buttons:
Report only – the program just reports to You on viruses if detected.

The report can be reviewed in the Object/Result status/log window or in 
the AVP report file if You enabled it. AVP will not disinfect or delete the 
infected objects (For more information on how to save the report see 
chapter 3.3.4, “The Options Tab Sheet”);

Display Disinfect dialog – when a virus detected the program 
opens the Disinfect dialog box (Figure 5.9). The box contains the 
infected file name, the detected virus name and the list of choices on 
how the object can be treated.
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Figure 5.9. The Disinfect dialog box 

 Disinfect automatically – AVP automatically disinfects all the 
infected objects if detected.

Attention! Not all the infected objects detected by the Redundant
scan mode (The AVP operation extra modes can be enabled/disabled in
the Options tab sheet) can be disinfected.

If You enable the Disinfect option button for infected system sectors 
(Boot, MBR, Partition Table) the following attention/confirmation 
message box will appear on Your screen: “It’s RISKY to disinfect 
sectors! We recommend You first to back up Your hard drive. Are 
You sure You want to disinfect now?”. If You confirm the operation 
AVP will immediately start disinfecting the sectors. If the answer is 
negative the scanning operation will be aborted. Then You may exit the 
program and back up Your hard drive prior to disinfecting.

 Delete object automatically – AVP automatically deletes all the
infected objects if detected.

If You enable this option button when started AVP will ask You for 
confirmation: «Are You sure You want to DELETE ALL the infected 
objects?»  (Figure5.10). Press Yes if You are sure to confirm the action
or No if You want to change the way the infected objects will be treated. 
If No AVP will open the Actions sheet for You to select some other 
action and continue the operation.
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Figure 5.10. The Delete objects automatically confirmation message
box

The two check boxes within the Actions tab sheet provide a user with
ability to make copies of the infected and suspicious objects if detected. 
Sometimes these copies can be very useful. For example if You enable 
Delete object automatically and instruct AVP to make copies of all the 
detected infected objects and start the viruscheck all the detected 
infected objects will be deleted but AVP will make copies for You to be 
able to restore them later.

That’s why we recommend You to check the following check boxes:
 Copy to Infected folder – enables AVP to copy the infected 

objects if detected to the corresponding folder. If the box is 
checked the below text field becomes available and a user is 
enabled to specify the folder for the infected files if detected to 
be copied to. The default folder name is Infected (located in the 
AVP folder).

 C  opy to Suspicious folder - enables AVP to copy the 
suspicious objects if detected to the corresponding folder. If the 
box is checked the below text field becomes available and a user
is enabled to specify the folder for the suspicious files if detected 
to be copied to. The default folder name is Suspicious.

Attention! 
Be careful with infected and suspicious objects and their copies! If

these objects are the executable files make sure not to start them. If
You copied the objects to some diskette do not leave it in Your floppy
disk  drive.  Because  if  by  accident  You  will  attempt  to  boot  Your
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computer with this diskette the virus will have a chance to infect Your
system again.

3.3.3.1.  The Disinfect Dialog Box
If the Display Disinfect dialog option button within the Actions tab 

sheet is enabled and while scanning AVP detected some infected object
the Disinfect dialog box () will appear on Your screen. In the box You 
can review the infected file name, the detected virus name and the list of
choices on how the object can be treated.

Figure 5.11. The Disinfect dialog box
The box enables You to make AVP to treat the infected objects the 

following ways:
 Report only - enables AVP just to develop a report on the infected 

object and the virus;
 Disinfect - enables AVP to disinfect the infected object, i.e. to 

delete the virus from the object and to recover the object to match 
it’s original;

 Delete - enables AVP to delete the infected object from disk);
 Copy to Infected folder – enables/disables AVP to copy the 

infected object if detected to the corresponding folder (in case You 
didn’t enable the corresponding check box within the Actions tab 
sheet). If this option is enabled the infected object when detected 
will be copied to the Infected folder located in Your AVP folder.

 Apply to All the infected objects – enables AVP to automatically 
treat all the detected from now on infected objects the way selected 
by a user in the Disinfect dialog box. It means that next time the 
infected object is detected the Disinfect dialog box wouldn’t be 
displayed on the screen and the object would be treated 
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automatically. The operation results may be reviewed in the AVP 
log/status window, report file, if You enabled the one, and will be 
displayed in the Statistics tab sheet after the scanning is finished.

3.3.3.2. Unrecoverable Objects.
To our regret it’s not always possible to recover the infected object 

as there are some viruses damaging file data in the irreversible way. If 
You’ll make an attempt to disinfect the unrecoverable object the 
following message will appear on the screen: «OBJECT_NAME 
infected by the VIRUS_NAME virus cannot be recovered. Do You 
want to delete the object?». Where «OBJECT_NAME» is a name of 
the infected object and «VIRUS_NAME» is a name of the virus (Figure 
5.12).

Figure 5.12. The AVP unrecoverable object message
If You press Yes in the message box (Figure 5.10) the object will be 

deleted and AVP will display the following message: «Do You want All 
the unrecoverable objects to be deleted?» (Figure 5.). If You press 
Yes all the detected from now on infected objects that cannot be 
recovered will be deleted. If No, next time AVP will detect some 
unrecoverable object the message similar to Figure 5.12 will be 
displayed on the screen.

Figure 5.13. AVP message on weather You want All the 
unrecoverable objects to be deleted.

If You press No in the message box (Figure 5.10) the object will be 
ignored and AVP will display the following message: «Do You want All 
the unrecoverable objects to be deleted?» (Figure 5.14). If You press
Yes all the detected from now on infected objects that cannot be 
recovered will be ignored. If No, next time AVP will detect the 
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unrecoverable object the message similar to Figure 5.12 will be 
displayed on the screen.

Figure 5.14. AVP message on weather You want All the 
unrecoverable objects to be ignored.

3.3.4. The Options Tab Sheet/The program additional settings
You may employ the Options sheet (Figure) elements to customize 

the program and adjust the AVP extra scanning and reporting modes.
This tab sheet contains eight check boxes. To check a check box 

click Your mouse left button on it.
The three following boxes provide a user with ability to 

enable/disable the AVP extra scanning modes:
 Warnings – enables/disables the additional viruschecking device. If 

enabled AVP will warn a user if the files or sectors being 
viruschecked contain any modified or damaged virus and if any 
similar to a virus instruction lines detected in the computer memory;

 C  ode Analyzer – enables/disables the Code Analyzer heuristic 
device providing a user with ability to detect the AVP-unfamiliar 
viruses in the examined objects;

Figure 5.15. The Options tab sheet
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Redundant scan – enables/disables the full-scan device providing 
the ability to viruscheck not just the entry points (system processing 
entry points) but the whole contents of examined files.

Attention! 
The Redundant scan mode is recommended if no virus was detected

the standard way but the system still  operates the out-of-the-ordinary
way ( i.e. frequent “self”-restarts, some programs operation unnatural
slowdown and etc.). In other cases we do not recommend to employ the
mode as it  notably  slows down the scanning rate  and increases the
probability of “false shots” while checking the virus-free files.

The following check boxes provide a user with ability to 
enable/disable the AVP extra reporting modes:

Show clean objects in the log – during the scanning operation if 
enabled displays the virus-free objects names in the AVP status/log 
window Object area. In the status/log window Result area in this case 
will be displayed “ok”.

Attention! The  mode  if  enabled  slightly  slows  down  the  AVP
operation.

Show pack info in the log – during the scanning operation if 
enabled displays some additional information line in the Object/Result 
status/log window related to the packed files and archives checked by 
AVP. The packed object (archive) name will be displayed in the Object 
area and in the Result area You will be able to review the name of the 
corresponding packing program (archiver);

The Customize button also located within the Options sheet. If You 
press the button the Customize AVP settings box containing the 
following check boxes will appear on Your screen:

Sound effects – enables/disables the AVP sound.
Select path for scan with single click – enables/disables a user to 

appoint the AVP viruscheck path (the Location sheet) by single-click. 
Double-click is the standard way

Pop-up AVP window after scan finish - enables/disables a user to 
review the AVP viruscheck results right after the scanning operation is 
finished. If You uncheck the box You will be able to review the results 
later.

Switch to statistics tab after scan start – if checked enables 
automatic switch to the Statistics tab for a user to supervise the 
scanning operation in progress.

Switch to statistics tab after scan finish – if checked enables 
automatic switch to the Statistics tab for a user to review the scanning 
operation results right after the operation is finished.
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Insert next disk prompt for removable drives - enables/disables 
the corresponding message. If the box is checked AVP when 
viruschecked a floppy disk will offer You to scan one more. If you always
scan no more than one floppy disk we recommend the message to be 
disabled.

Attention message about redundant scanning - enables/disables 
the AVP message box warning that the redundant scanning takes more 
time. If You always employ the redundant scanning mode the message 
is useless and may be disabled.

Attention message about delete all infected objects option – 
enables/disables the following AVP message: «Are You sure You want
to DELETE ALL the infected objects?» (For more information see 
chapter “The Actions Tab Sheet/ Defining the Way the Infected and/or 
Suspicious Objects (if detected) will be Treated”). In the standard situation 
this check box is checked. If You always delete the infected objects the 
message is useless and You may uncheck this check box to disable it.

Other attention messages – enables/disables all the other attention
messages (For more information see “The Actions Tab Sheet/ Defining 
the Way the Infected and/or Suspicious Objects (if detected) will be Treated”).

You may enable/disable these AVP settings the standard way by 
mouse or keyboard. To check/uncheck one of the check boxes single-
click Your mouse left button on it or select it by the arrow keys and 
press the Spacebar key.

To open the Customize AVP sheet You may also click the Customize
command in the Tools menu (For more information see chapter “The 
Tools Menu”).

The Options sheet right-side area enables a user to develop the 
Report file. All the information displayed in the Object/Result status/log 
window and the Statistics sheet can be saved in this file. This right-side 
area contains three check boxes and two text fields. The check boxes 
are:

Report file – enables/disables AVP to develop a report file. If the 
check box is checked the below text field becomes available and a user 
is enabled to type in the report file name. The default report file name is 
Report.txt.

If the Report file check box is checked the below text fields and 
following check boxes become available:

Append – if checked enables AVP each time the viruscheck is 
finished to add the developed report to the report file contents. It’s very 
useful since any time You want You will be able to review reports on 
several or all the previous viruschecks. If the box is unchecked the 
report file will contain only the last viruscheck report.
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Limit size of report file, Kb: - if checked enables a user to limit the 
report file size. The value (Kb) can be entered in the below text field (the
default value is 500 Kb).
3.3.5. The Statistics tab sheet/Viruscheck Statistics

When the scanning operation is finished the «Statistics» tab sheet 
(Figure 5.16) will be automatically activated. This sheet contains the 
scanning/disinfecting results.

Figure 5.16. The Statistics tab sheet
The sheet is divided in two areas (Scanned and Found):
Scanned – this the sheet area contains numbers of the viruschecked

sectors, files, folders, archives and packed objects. The Scan time is 
also specified within the area.

Found – this area contains the numbers of:
 detected viruses;
 virus bodies (i.e. the quantity of files infected by some AVP-familiar 

virus);
 disinfected objects (i.e. the objects the viruses were correctly 

deleted from);
 deleted objects;
 warnings (i.e. the quantity of objects containing a code similar to the

known virus modification);
 suspicious objects (i.e. the Code Analyzer notifications);
 corrupted objects;
 I/O errors.
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3.4. Menu Bar
3.4.1. File Menu

The File menu enables a user to save and load various the program 
settings groups. If You adjusted the program the desired way and saved
these settings to the profile ( The file with the PRF extension) next time 
You want to adjust the program the similar way You don’t have to waste 
Your time while enabling/disabling all the options again. Simply load the 
profile You saved all the desired settings to. You also may use the 
profiles developed by Kaspersky Lab for different AVP tasks. To obtain 
the profiles the AVP legal users should contact the Kaspersky Lab Help 
Desk 

Figure 5.17. The File menu
The File menu (Figure 5.17) contains the following commands:
Save profile as default – enables a user to save current settings to 

the default profile (default.prf) that will be automatically loaded together 
with AVP. We recommend You to save to the default profile the most 
frequently used settings group.

Note: The AVP standard set default profile (default.prf) contains just
the basic settings.

Load profile... – enables a user to load settings from a profile. If the 
command is selected the Load profile dialog box (Figure 5.18) 
containing Your profiles list will appear on Your screen. Appoint the 
desired profile in the box and press the Open button. The program 
current settings will be replaced by the profile.

To delete some unwanted profile from the profile list click Your 
mouse left button on the profile name to highlight it and press the 
<Delete> key.
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Figure 5.18.The Load profile dialog box
Save profile As... - enables a user to save the program current 

settings to a profile. If the command is selected the Save profile dialog 
box (Figure 5.19) will appear on Your screen. Specify the name of the 
desired profile You want to save the settings to in the File name text 
field within the box and press the Save button.

Figure 5.19. The Save profile dialog box
Exit – enables a user to shut down the program.

3.4.2. The Scan Menu
The Scan menu contains the commands similar to the ones of the 

Scan Now/Stop button:
 Scan now – starts scanning;
 Stop – aborts scanning.
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Figure 5.20. The Scan menu. Scanning is not started.

Figure 5.19. The Scan menu while scanning
When not scanning the Scan menu Stop command is unavailable 

(Figure 5.18) and it becomes unavailable after the scanning operation is
started (Figure 5.19).
3.4.3. The Tools Menu

The Tools menu (Figure 5.20) contains the following commands: 
Update now, Customize, Find in report and Make Virus List.
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Figure 5.20. The Tools menu
The Update now command opens the AVP Updates dialog box 

enabling a user to automatically update the program antivirus 
databases. By means of this dialog box You can update Your antivirus 
databases through Internet or attach the updates if present in Your PC.

If updating Your databases through Internet AVP will connect your 
PC to the HTTP or FTP server containing the AVP up-to-date database 
files and download them. If You already have the updates in Your PC 
just specify the corresponding path in the appropriate text field within the
AVP Updates dialog box. In this case these updates will be copied to 
Your AVP folder and the outdated antivirus databases will be deleted.

Note: Anyhow the updating operation would be successful  only if
Your AVP databases developed by Kaspersky Lab were not damaged,
corrupted or in any way modified.

The Customize command is similar to the Options sheet Customize 
button (For more information on the button see chapter 3.3.4, “The 
Options Tab Sheet”).

The Find in report command opens the Find in report dialog box . If 
You want to review the scanning information on some file viruschecked 
by AVP use the command to find it in Your AVP report file. The 
command can by very useful if Your report file is a large-sized one. In 
the box You may specify the search character string (for example the 
desired file name) and then press the Find Now button to start the 
operation. . The dialog box can be opened by the <Ctrl-F> key 
combination. (For more information see chapter “The Object/Result 
Status/Log Window Messages”).
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The Make Virus List command develops and screens a list of all the
AVP-familiar viruses. To do it the program looks through all the attached
antivirus databases and screens all the listed in there virus names. This 
option helps effectively and timely to update the AVP versions. To 
screen the virus list select the Make Virus List command within the 
Tools menu. The list will be displayed in the Object/Result status/log 
window.

3.4.4. The Help Menu
The Help menu (Figure 5.21) contains the following commands:

Figure 5.21. The Help menu
 C  ontents – displays the AVP Help file contents. The command 

starts AVP Help. If You select the command the Help Topics: 
AntiViral Toolkit Pro tab window Contents sheet containing the Help 
topics tree will appear on Your screen.

 AVP on the Web – if linked to the Internet You may use the 
command to download the latest information about AVP and the 
Kaspersky Lab new products.

 A  bout AVP – displays information about the AVP developers, Your 
AVP version number, Your registration data and other AVP-related 
information. If You press the Support button within the About AVP 
info window You will be provided with the AVP developers contact 
information.
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3.5. Object/Result Status/Log Window Messages
While the AVP scanning operation is in progress the Object/Result 

status/log window located in the AVP main window bottom area displays
the viruscheck/treatment results (the results of this scanning operation 
being also saved to the report file, if enabled). During the operation the 
Tracking check box appears within the AVP main window.

The Tracking check box if checked provides a user with ability to 
supervise the viruscheck in progress (the viruscheck status) enabling 
the Object/Result status/log window auto-scrolling mode.

To find some certain file viruscheck information in the report 
displayed in the window a user may employ the Find in report command
within the Tools menu. If You click the command or press the <Ctrl-F> 
key combination the Find in report dialog box will appear on Your screen
(Figure 5.22). In the box You may specify a search character string and 
then press the Find Now button to start the search operation. To repeat 
the operation for the same string just press the <F3> key.

Figure 5.22. The Find in report dialog box
In the status/log window left-side area (the Object area) names of the

objects being viruschecked by AVP are displayed and in the right-side 
area (The Object area) a user may see the following messages:

ok
No virus and the virus-similar instruction sets were detected in the 

viruschecked file or sector. This message will be displayed only in case 
the Show clean objects in the log check box within the Options sheet is 
checked. If the box is not checked the virus-free objects information will 
not be displayed in the window or saved to the report file.

Infected: VIRUS_NAME
The VIRUS_NAME virus (e.g. OneHalf.3544) is detected in the 

viruschecked file or sector. 
Disinfected: VIRUS_NAME
The VIRUS_NAME virus is successfully deleted from the 

corresponding file/sector or if the virus is a memory-resident one the 
computer memory is deactivated. If there is a message on a memory-
resident virus in Your computer we recommend You to restart the 
computer right after the scanning operation is finished.

Deleted: VIRUS_NAME 
The object infected by the VIRUS_NAME virus is deleted.
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Disinfection failed: VIRUS_NAME
The file is infected by the VIRUS_NAME virus in the, so called, 

incorrect way (If treated can be damaged) or the corresponding 
file/sector disk is a write protected one.

Warning: VIRUS_NAME
An instruction combination that looks like the VIRUS_NAME virus is 

detected in the viruschecked object, but further check indicates that the 
instruction set doesn’t match the virus. If during a viruscheck You see a 
lot of the similar messages the probability of Your computer being 
infected by the VIRUS_NAME virus new modification is very high.

Suspicion: VIRUS_TYPE
In the file and/or sector by the Code Analyzer device (for more 

information see chapter 3.6, «Code Analyzer») an instruction set similar 
to a virus of the VIRUS_TYPE type is detected. 

Corrupted: FILE_NAME
The file internal structure doesn’t match the one corresponding to the

given file format.
I/O error
The file or sector disk is a write protected one or some system error 

has occurred.
Packed: PACK_NAME
The viruschecked file is a packed or immunized one. PACK_NAME 

is a name of the packing program the object was packed by.
Archive: ARCHIV_NAME
The viruschecked file is an archive. ARCHIV_NAME is a name of the

corresponding archiver.
Unknown format
Unpacking Engine (Extracting Engine) failed to unpack (extract) the 

packed file (archive). The failure may occur if the packed file was 
packed by a packing program new version or if the archive is a 
passworded or damaged one.

3.6. Code Analyzer
Code Analyzer (a heuristic scanner) checks files and sectors codes 

of the being scanned program down the various algorithmic legs for the 
virus-similar instructions. In case the instructions ( to open a file and 
code into it, or to intercept the interrupt vectors or etc.) will be detected 
the following message will appear on Your screen:

Suspicion: VIRUS_TYPE
Where VIRUS_TYPE may be substituted with the following words:
Com – the file looks like being infected by some virus infecting the 

COM files;
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Exe – the file looks like being infected by some virus infecting the 
EXE files;

ComExe - the file looks like being infected by some virus infecting 
both the COM/EXE files;

Com (or Exe or ComExe)TSR - - the file looks like being infected by
some memory-resident virus infecting the COM (or EXE or COM/EXE) 
files;

Boot – the file/sector looks like being infected by some boot virus or 
looks like a boot-virus installer;

Trojan – the file looks like some kind of Trojan (Trojan is a kind of 
destructive program that according to some conditions erases disk data 
or causes hang-ups or etc.).

In the abstract the AVP heuristic algorithm just like any other of the 
category may sometimes result in a “false shot” (takes a virus-free file 
for the infected one), but Code Analyzer was tested many times and 
checked a lot of files and was never actually deceived. It enables us to 
submit that our heuristic device (Code Analyzer) is a very reliable one. If
still while checking Your files by Code Analyzer You encountered the 
“false shot” pls. inform us about this and send the virus-free files that 
were taken for viruses to Kaspersky Lab where they will be studied.

While scanning Code Analyzer checks a lot of algorithmic legs of a 
program down to several sublevels. Hereupon if Code Analyzer is 
enabled the AVP operation rate slows down greatly. But this device 
detects 80% of all the Kaspersky Lab antivirus database viruses and we
believe that the newborn and therefore the AVP-unfamiliar viruses will 
be detected with the same degree of probability.

Attention!
The Code Analyzer current version doesn’t delete viruses from the

files marked as the «suspicious» ones.  To delete the AVP-unfamiliar
virus refer to a system programmer or contact Kaspersky Lab.

3.7. Unpacking Engine
Nowadays the executable file packing utilities are very popular. The 

software developers pack their products and supply them together with 
some special unpacking unit. When such an executable program is 
started this unit unpacks it to RAM and then executes it.

The virus infected files can be packed by such packing utilities 
together with the virus-free ones. If scanned by an ordinary antivirus 
scanner the infected file would be defined as a virus-free one as the 
virus body was packed together with the program code. Unpacking 
Engine unpacks the files that have been packed by the most popular 
packing utilities (DIET, PKLITE, LZEXE, EXEPACK, COMPACK, 
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COM2COM of various versions) to a temporary file for AVP to 
viruscheck it. If some virus is detected inside the file AVP is able to 
delete it. As a result the original packed file is substituted by the 
unpacked and disinfected one. The unpacking device is able to correctly
unpack files compressed one or several times.

Our unpacking unit is also enabled to deal with some immunizer 
versions (For more information see chapter 1.3.4) such as CPAV and F-
XLOCK, and with some enciphering programs (CryptCOM).

The latest AVP versions Unpacking Engine device will be updated to 
deal with new immunizers, packing and enciphering programs.

3.8. Extracting Engine
Nowadays the antivirus capable of checking archives became a kind 

of crying need. The infected file can stay in an archive for long, even 
years, and the virus will be inactive and therefore invisible for You, but 
some day when You extract this file the virus may break loose and ruin 
Your system. The BBS archives are especially dangerous.

If You deal with infected archives Extracting Engine can be of help. 
While scanning some archive Extracting Engine extracts the files 
according to specified mask to a temporary file for the AVP main unit to 
be able to check it. When viruschecked the temporary file being erased.

The Extracting Engine current version contains codes enabling it to 
extract the following archives: ARJ, ZIP, LHA, RAR of all the existing 
currently existing versions (including the RAR version 2.0, that can be 
extracted by few antivirus programs in the world).

Notes:
1.  AVP doesn’t  delete  viruses from the infected archives but  just

detects them.
2.  Extracting  Engine  is  not  capable  of  extracting  the  passworded

archives.
AVP will detect the infected file even though it was enciphered by the

CryptCOM utility, then packed by PKLITE and added to the PKZIP 
archive.

3.9. AVP Help
A user is able to access the AVP Help any time even during the 

scanning operation. To call for Help just click Your mouse left button on 
the Help menu and select Contents. The Help Topics: AntiViral Toolkit 
Pro tab window Contents sheet (Figure 5.25) will appear on Your 
screen.
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The AVP Help Topics tab window looks like the Windows 95 one and
can be managed the similar way.

The Help Topics window Contents tab sheet contains the AVP Help 
topics tree. To open some topic book double-click Your mouse left 
button on it or highlight it’s title and press the Open button. To open the 
book section double-click Your mouse left button on it or highlight it’s 
title and press the Display button. The AVP Help window containing the 
required information will appear on Your screen.

To close the book double-click Your mouse left button on it or 
highlight it’s title and press the Close button.

The Help Topics window Index tab sheet contains the AVP Help 
topic keywords listed alphabetically. To find some topic: type in the first 
few letters of the keyword You want to search for, or scroll through the 
Help Index using Your mouse and double-click the mouse left button on 
the section You want to look through, or highlight the word and press 
the Display button.

Figure 5.23. AVP Help
You may also call for the on-line Help by pressing the <F1> key. In 

this case the AVP Help window containing information on the currently 
active AVP main window tab sheet will appear on Your screen.
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4. Running AVP Monitor
AVP MonitorTM is a memory resident antivirus program checking 

up files and sectors references. To enable an object reference AVP 
Monitor checks the object for viruses and in case of infection depending
on the way You adjusted the program offers You to disinfect the infected
object or to delete it or to deny the infected object access. This way 
AVP Monitor is able to detect and delete the virus before Your system 
is actually infected. 

4.1. Getting Started
To start AVP Monitor click the Start button (Windows 95/98) point to

Programs, then point to the AntiViral Toolkit Pro group and click AVP 
Monitor. Optionally You can start the program by executing the 
Avpm.exe file

If while installing AVP onto a computer You enabled the installation 
program to add AVP Monitor to the StartUp group the program will be 
automatically started right after the Windows start.

After AVP Monitor loaded the corresponding icon will appear in the 
taskbar Notification area (right side). To open the AVP Monitor main 
window You've got just to double-click the icon.

Figure 6.1 The AVP Monitor context menu
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Click Your mouse right button on the taskbar AVP Monitor icon to 
display a context menu (Figure ) on Your screen. The menu contains 
the following frequently used commands:

Disable Monitoring (when AVP Monitor enabled)/Enabling 
Monitoring (when AVP Monitor disabled) – provides a user with ability 
to disable/enable AVP Monitor. While AVP Monitor disabled (the icon 
red strip changes the color to black) the viruscheck is not being 
performed. 

AVP Monitor Settings – opens the AVP Monitor main window;
Unload Monitor – removes AVP Monitor from RAM. 

4.2. AVP Monitor Main Window
The AVP Monitor main window contains 5 the following tabs: 

General, Objects, Actions, Options, Statistics. While switching 
between the tabs and enabling/disabling the options You can customize 
the program and change it’s settings.

Attention!
For all the made changes to take effect You have to press the Apply

button (the AVP Monitor main window will not be closed enabling You to
continue the setting procedure) or the OK button (the main window will 
be reduced to an icon in the taskbar Notification area).

To open the AVP Monitor Help press the Help button or the <F1> 
key on Your keyboard.

Note: The  button in the AVP Monitor main window upper-right 
corner doesn’t operate the standard way. If You press the button the 
program operation will not be terminated but the window will be reduced
to the icon.

There are two ways to swap the program out of memory: press the 
Unload Monitor button in the AVP Monitor General tab sheet or click 
Your mouse right button on the taskbar AVP Monitor icon and left button
on Unload Monitor.

4.3. The Tabs
4.3.1. The General Tab Sheet

The AVP Monitor command buttons are located in the General tab 
sheet central area (Figure 6.2). In the same area is also located a 
progress field enabling a user to review the AVP Monitor on-scanning 
status.

The Enable Monitoring check box enabling/disabling the monitor is 
located in the General sheet upper area. While AVP Monitor is disabled
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(the icon red strip changes the color to black) the viruscheck is not being
performed.

To enable the monitor check the checkbox and press the Apply or 
OK button. 

To disable the monitor uncheck the checkbox and press the Apply or
OK button.

Figure 6.6 The General tab sheet
The Update Now button starts the AVP Updates utility enabling You 

to update the antivirus databases.
The Unload Monitor button swaps the program out of memory. This 

button is similar to the AVP Monitor context menu Unload Monitor 
command.

The Scan all local hard drives button starts Your computer hard 
drives full viruscheck. When the viruscheck is started the Pause scan 
button becomes available.

The Pause scan button when pressed during the scanning operation
suspends the operation and resumes it when pressed again.

Attention!
By swapping AVP Monitor out of memory You will disable Your 

computer permanent antivirus protection!

4.3.2. The Objects tab sheet
This tab sheet (Figure 6.3) provides a user with ability to specify the 

file masks to be viruschecked.
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Figure 6.7 The Objects tab sheet
You may specify one of the following file masks:

 Smart – to viruscheck the programs, i.e. objects with internal 
formats similar to the executable files and all the files with the 
following 
extensions: .BAT, .COM, .EXE, .OV*, .SYS, .BIN, .PRG, .VxD, .DLL,
.OLE.;

 Programs – to viruscheck all the BAT, COM, EXE, OV*, SYS and 
etc. extensions files.

 All files – to viruscheck all files regardless of their internal format;
 User defined – to viruscheck a user defined file masks. The file 

masks of the files to be checked should be specified in the text field 
separated by commas. Example: *.EXE, *.COM, *.DOC .

If You check the Process embedded objects  check box the 
probability of a virus to be detected will be increased but Your programs 
operation will slow down.(Not to spend time while viruschecking the 
large-sized files You may limit the size of files to be checked. To do it 
just check the Process if size at most (Kb): check box and specify the 
maximum size value in the text field.)
 Packed files - enables/disables Unpack Engine capable of 

decompressing the packed by utilities (PKLITE, DIET, LZEXE and 
etc.) files to make them viruscheckable.

 Archives - enables/disables Extract Engine providing AVP Monitor
with ability to viruscheck the archives (ARJ, ZIP, LHA, RAR).

 Mail databases - enables/disables AVP to scan the Microsoft 
Outlook and Microsoft Exchange e-mail databases (files with the 
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PST and PAB extensions and also the MS Mail files). AVP Monitor 
viruschecks the unpassworded databases as well as the password 
protected ones.

 Plain Mail formats - enables/disables AVP to viruscheck e-mail 
files of the following formats: Eudora Pro & Lite, Pegasus Mail, 
Netscape Navigator Mail, JSMail SMTP/POP3 server.

4.3.3. Actions tab sheet
 The Actions tab sheet (Figure 6.4) provides a user with ability to 

define the way the detected by AVP Monitor infected and/or 
suspicious objects will be treated.

 You may choose on of the following ways to treat the infected 
object:

 Deny access to object – the infected objects access will be denied;
 Disinfect automatically – AVP Monitor in case some infected 

object detected will not ask for instructions but will disinfect the 
object automatically;

 Delete object automatically – all the detected infected objects will 
be automatically deleted. If the check box is checked the following 
message will appear on Your screen: «Are You sure You want to 
DELETE ALL the infected objects?» Press Yes to confirm the 
action or No to return to the AVP Monitor main window.

Figure 6.4 The Actions tab

4.3.4. Options Tab
This tab sheet (Figure 6.5) enables a user to employ the AVP 

Monitor extra scanning and reporting modes.
Here You may check/uncheck the following check boxes:
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 Warnings - enables/disables the additional viruschecking device. If 
enabled AVP Monitor will warn a user if the files or sectors being 
viruschecked contain any modified or damaged virus and if any 
similar to a virus instruction lines detected in the computer memory;

 C  ode Analyzer – enables/disables the Code Analyzer heuristic 
device providing a user with ability to detect the AVP-unfamiliar 
viruses in the examined objects;

 Report file - enables/disables AVP Monitor to develop a report file. 
If the check box is checked the below text field becomes available 
and a user is enabled to type in the report file name. The default 
report file name is Avpm_rep.txt;

 Limit size of report file, Kb: - if checked enables a user to limit the 
report file size. The value (Kb) can be entered in the below text field 
(the default value is 500 Kb).

Figure 6.5 The Options tab sheet
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4.3.5. Statistics tab sheet

Figure 6.6 The Statistics tab sheet
This tab sheet displays the on-scanning status information about the 

numbers of:
Checked objects; 
Infected objects; 
Warnings;
Suspicious objects (objects suspected of being infected);
Disinfected objects;
Deleted objects.
The sheet also displays the following information: 
Last infected object: – the last detected infected object full-path 

name; 
Virus name: – the last detected virus name.
Last checked object: - the last viruschecked object full-path name.
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4.3.6. About tab sheet

Figure 6.7 The About tab sheet
This tab sheet (Figure 6.7) displays some information about the 

program (the version number, the last update date and a number of the 
AVP-familiar viruses, registration information, information about the 
manufacturer). The Support button if pressed will inform You about the 
contact information for You to acquire the services Kaspersky Lab offers
to the AVP legal users.

4.4. AVP Monitor The /q Switch Start
If AVP Monitor started from the command line with the extra switch

/q the specific mode will be loaded forbidding a user to:
 unload the program (the Unload Monitor context menu command 

and the Unload Monitor button in the General tab will be 
unavailable),

 disable the program (the Disable Monitoring context menu 
command and the checked Enable Monitoring check box in the 
General tab will be unavailable),

 change the program settings (all other options will be unavailable).
 In this mode You can review the Statistics tab sheet as well as all 

the unchangeable settings.
To start AVP Monitor with the /q switch You must do, for example,

the  following:  press  the  Start  button  and  click  Run  calling  the  Run
command box, type in the full-path AVPM.EXE file and the switch and
press OK. The Run box command string may be similar to:

C:\Program Files\AntiViral Toolkit Pro\Avpm.exe /q
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5. AVP Control Center (AVPCC)
The AVP Control Center integrated shell utility within the AntiViral 

Toolkit Pro package is a kind of careful supervisor looking after the 
juniors, other AVP components. The AVP shell is developed to regulate 
the AVP components installation and updating operations, to schedule 
various Tasks and to check their performance results.

Availability of the consolidated information on all the installed AVP 
components and their versions enables a user to efficiently 
communicate with the Kaspersky Lab Help Desk department 
representatives and timely to decide on weather the current AVP 
components should be updated. Availability of the automatic updating 
option provides the ability to regularly download the AVP components 
up-to-date versions and to renew the antivirus databases.

By means of the AVPCC shell you are enabled to schedule the AVP 
components performance. So now you do not have anymore regularly to
put off your business and spend your time and efforts to protect the 
computer from viruses! Just use the AVP Control Center to schedule the
AVP components to regularly test your computer and AVP will do it for 
you.

The AVP Control Center ability to automatically start the “external” 
programs enables you to employ the shell as a conventional task 
planner. In this case generally no other auto-start means should be 
used what enables you to save Your PC recourses for some other 
tasks. Besides now the tasks related to Your computer antivirus 
protection and other tasks will be synchronized so there will be no more 
any chance for them to conflict each other.

If during the AVP installation you check the corresponding check box
the AVP Control Center will be automatically installed onto your 
computer.

5.1. Starting and Managing AVPCC
To start the shell:
Press the Start button.
Point to Programs.
Point to the AntiViral Toolkit Pro group.
Point to AVP Control Center and click on it.
You may add AVPCC to the StartUp group. Some versions of the 

AVP installing program do it automatically but if Your AVP installation 
program is not armed with this option you should use the Windows 
Taskbar to add AVPCC to the StartUp group manually. If after the 
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Windows restart You don’t see the AVPCC icon in the taskbar 
Notification area meaning that Your AVPCC isn’t loaded do it manually.

When the AVP supervisor is started the AVPCC icon ( ) appears in
the Windows taskbar Notification area.

To manage AVP Control Center You must use the shell main context
menu. To display the menu click your mouse right button on the AVPCC
taskbar icon ( ).

Figure 5.1 The AVPCC main context 
menu

The AVPCC main context 
menu contains the following 
commands:

Scan my hard disks 
manually – starting of 
Scanner program;

AVP Control Center – 
displays the AVPCC main 
window;

About – displays the 
window informing a user on 
the AVP software developers 
and Your AVP version 
number.

Help – displays the AVP 
Help Topics window;

Exit – exits AVPCC.
To display the AVPCC 

main window select the AVP 
Control Center command 
within the main context menu 
or just double-click the AVPCC
icon in the Windows taskbar 
Notification area.

Figure 5.2 The AVPCC main window 
Components tab sheet

5.2. The AVPCC Main Window
The supervisor main window contains three the following tab sheets: 

Components, Tasks, Statistics, Security and Report.
The AVPCC main window is equipped with no menu bar because 

here You may use context menus to manage the AVP components.
The following buttons are located in the window bottom area: OK, 

Cancel, Apply and Help. If You make some adjustments within the 
window and press OK all the changes will take an effect and if to press 
the Cancel button all the made by You changes will be cancelled. In 
both the cases the window will disappear from Your screen. But if You 
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make some adjustments and press the Apply button all the changes 
made by You will take an effect and the window will not be closed for 
You to continue the adjustment procedure. If You press the Help button 
the AVP Help Topics window will appear on Your screen.

If the AVPCC main window is closed it doesn’t mean that the shell 
operation is shut down what is indicated by the AVPCC icon in the 
Window taskbar Notification area. To unload AVPCC You should select 
the Exit command within the AVPCC main context menu.

If You unload or suspend the AVPCC operation the prior started 
Tasks will not be aborted.

The AVPCC main window contains the tab sheets developed to 
manage the AVP package components (Components tab sheet), to 
supervise the Tasks automatic start (Tasks tab sheet), to report on the 
Tasks performance (Statistics tab sheet), to provide safety (Security 
tab sheet) and to control alerts (Alerts tab sheet)
5.2.1. “Components” tabs sheet
The sheet contains the list of names and version numbers and releases 
of all the installed onto Your computer AVP package components. For 
the AVP antivirus database the last update information is displayed.

Figure 5.3 The Tasks tab sheet

5.2.2. “Tasks” tab sheet
This tab is used to control

tasks.
Task means starting 

program component if AVP 
package or any other 
program with predefined 
settings. Task starts 
according to schedule, on 
event or manually.
The particular tab shows list
of tasks, time, properties 
and task’s status.

Left column contains icons and tasks’ names.
Middle column contains planned time and other conditions of task 

execution. 
At the right column of the list you can see tasks’ status.
At the left side of the window there is toolbar. It has the same 

functions as dynamic menu that causes by right button of the mouse.
In this tab you may perform several operations:

Create new task. Select “New” item in dynamic menu or press  
button of toolbar. After that you will see dialog widow “New task”.

Change settings of the existing task. Select task in the list and 

5 8



double click it or push button . After that you should see dialog 
window “Task Properties”. Start task manually. Highlight task in the 
list and select “Start” item in dynamic menu or press button  on 
toolbar.

Stop task manually. Highlight task in the list and select “Stop” item
in dynamic menu or press button  on toolbar.

Remove task. Highlight task in the list and select “Delete” item in 

dynamic menu or press button .
Enable/disable task. To do that highlight the particular task and 

select “Enable” item in dynamic menu. After that “Enable” item will be 
checked and task name will be highlighted with cross icon (if you enable
task) or this item will be unchecked and cross icon will disappear (if you 
disable task).
Reload antiviral databases while operating. Select task and start item

“Reload bases” in dynamic menu or press button  on toolbar. Then
task will be stopped, antiviral databases will be reloaded and task will be
restarted. This function is available only for resident tasks such as AVP 
Monitor.

Figure 5.4 “Statistics” tab sheet.

5.2.3. “Statistics”  tab
sheet
“Statistics” tab sheet 
enables a user to review the 
Tasks performance results 
and the being currently 
performed Tasks status, for 
example the AVP Monitor 
status. Being enabled easily 
to check the results of the 
AVP components 
performance

You may promptly to analyze and compare them to timely spot some 
infection indications and prevent a virus attack.
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“Security” tab sheet

5.2.4. “Security” tab sheet
This tab is responsible for

customizing of security 
functions. It means 
password protection, IP 
address settings for remote 
control and disabling some 
tasks).

Window is divided into 
three parts. At the top of the 
window there are controls to 
control password protection.

In middle part of the window you may see controls that allows us to 
enable/disable starting of forbidden tasks.

At the bottom there are controls to customize remote control of your 
computer.

Several functions are available.
Set/unset password for remote control options of AVP Control 

Center and program termination. Enable “Enable password 
protection” item and click the mouse on corresponding item. Then icon 
of the task will change. If you set password you will see picture of “key” 
on the icon if you unset password then “key” will disappear. By default 
the password of the item is the password that you entered during 
installation procedure.

To change password activate “Enable password protection” item 
and press button “Set password” and you will see window “Change 
password”. Then enter new password into textbox “New password” 
and reenter password in textbox “Confirm password”.

For example you want set password “AVP” only for customizing of 
remote control options. To do it activate “Enable password protection” 
item, click mouse on corresponding task to show “key” on the icon. 
Other components must be unprotected by password. The attribute of 
disabling the password is the absence of “key” on task icon. Then press 
button “Set Password”, enter password into both textboxes and press 
button “OK”.

Enabling/disabling interdiction to start tasks. This item allows us 
to forbid task of user program execution. Enable (disable) item “Disable 
‘Execute program’ task”.

Customizing of remote control. Remote control means control with
the help of Network Control Center. You may permit remote control from
any network computer or from particular computers. Pres button 
“Configure”. Then you will see window “Allowed IP addresses for 
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remote management”. Make corresponding settings in the window. 
This function is available only in AVP Platinum edition and in AVP for 
Windows NT Server.

“Alerts” tab

5.2.5. “Alerts” tab sheet
This tab is responsible for

control of posting of the 
messages that indicates 
occurred events during 
operating. These alerts are 
initiated by running tasks.

There are several modes 
of operation.

Do not send alerts. It 
means that running tasks will
not send messages about 
events during operating. 

To initialize this mode select corresponding item in the list “Alert 
sending”.

Send alerts through AVP Server. Alerts will be sent to server and 
they will be processed by AVP Network Control Center. This function is 
available only for AVP Platinum and AVP for Windows NT Server i.e. 
only for network versions. To initialize this mode select corresponding 
item in the list “Alert sending”.

Send alerts direct. It means that all messages will be sent to 
predefined e-mail. To initiate this mode select item “Send alerts direct”. 
Then enter e-mail of recipient in textbox “E-mail address”, select your 
profile in the list “Profile” and enter password of profile in textbox “Profile
password”. Last action is necessary to identify you as sender.

For example if you want system administrator who has Network 
Control Center on his computer to receive alerts than select item “Send 
alerts through AVP Server”.

5.3. Managing the AVP Components
If to double-click the AVPCC icon the AVPCC main window 

Components tab sheep will appear on your screen. To manage some 
AVP component you should open the corresponding context menu and 
select the desired command.

Within the AVPCC main window you may see a kind of table 
displaying all the installed onto Your computer AVP components and the
components related information. The table is separated in two columns. 
The first column lists names of all the installed onto your computer AVP 
components and the second displays the information related to the 
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components’ versions and releases. For the AVP antivirus database the 
last update date is displayed.

To call the details on some component do the following:
Click the component name or icon within the main windows 

Components sheet list to select the component;
Click your mouse right button on the selected component to display 

the context menu, point to Information… and click on it.
To install some new component by means of the AVP installation 

files do the following:
Click your mouse right button on some blank area within the 

Component sheet to open the context menu;
Point to the Install… command and click on it. A dialog box will 

appear on your screen;
In the dialog box enable the Local Folder option button;
Specify the desired file full-path name in the corresponding field or 

press the Browse button to select the desired file in the folder/file tree 
dialog box. (Usually AVP installation files being supplied on a diskette 
(the AVP distribution diskette). In that case just select the A drive and 
click on the desired file);

Press the Next button;
Wait until the desired component will be successfully installed onto 

your computer. While the installation will be in progress an indicator 
reflecting it’s course will be displayed on your screen.

5.4. Removing a Component
Sometimes you may need to remove some installed onto Your 

computer AVP component for various reasons, for example if You need 
to reinstall it.

To remove some AVP component from your system do the following:
Click the component name or icon within the Components sheet list 

to select the component;
Click your mouse right button on the selected component to display 

the context menu, point to Remove… and click on it.
Some special wizard-utility window will appear on your screen. 

Enable the Complete option button within the window.
To move to the next the wizard-utility window press the Next button 
Press the Finish button to enable AVPCC to automatically remove 

the component from your system.
As you may notice the wizard window contains the Custom option 

button. If to enable the button the wizard will offer you manually to select
the files, folders and system entries to be removed or modified. If you 
are not skilled enough to deal with this type of the component removal 
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enable this option only if it was specified in the AVP documentation or 
when advised by the AVP Help Desk department. In other cases do not 
enable the option button as any improper action while selecting the 
components manually may lead to loosing of data or could make your 
system unstable.

5.5. Managing the Tasks
Some certain program with defined settings and environmental 

conditions scheduled performance may be saved as a Task. The Tasks 
tab sheet enables a user to manage the Tasks.
5.5.1. The Task Types

According to the Task goals, programs being started by the Tasks 
and the features of their settings Tasks may be divided in two the 
following types: the Tasks running the AntiViral Toolkit Pro components 
and Other Tasks. According to the AVP component being employed the 
first group of Tasks may be divided in the following types:

AVP Scanner Tasks – for each AVP Scanner Task within the 
AVPCC tabs You may specify a group of settings (the way You want 
AVP Scanner to be adjusted) and schedule the scanner to be 
automatically run at some certain time or upon some certain event or as 
required.

AVP Monitor Tasks – for each AVP Monitor Task within the AVPCC 
tabs You may specify a group of settings (the way You want AVP 
Monitor to be adjusted) and schedule the periods when this group of 
settings should be active. The period may be scheduled to begin and 
end at some certain time, upon some certain event or specified by a 
user for the duration of some certain activity (for example for the period 
of installation of some new software or for the period of some from 
outside incoming programs or documents being copied to Your hard 
drive or for the period of processing of e-mail or etc.). You may schedule
AVP Monitor to be started with some certain settings or to activate some
temporary settings without restarted.

AVP Updates Tasks – for each AVP Updates Task you may specify 
the way and schedule some certain AVP component and/or the 
databases to be updated. AVP may be updated through the Internet or 
by a local network what saves time and efforts while linking to the 
updates, speeds up the operation and eases the package management.

5.5.2. Developing a Task
To develop a Task do the following:
Switch to the Tasks tab sheet;
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Click Your mouse right button on some blank area within the sheet or
press the <Ins> key on Your keyboard to open a context menu;

Select New… to display the New Task dialog box;
In the Task Name text field specify a name of the Task You want to 

be developed. Make sure the name corresponds to the Task contents, 
for example, Checking a CD suspected for viruses;

In the drop-down list select the desired Task type;
Press the OK button to configure the Task start and performance 

conditions.

Figure 5.5 The New Task dialog box
The windows design and the adjustment order depend upon the type

You specified for the Task to be developed.

5.5.3. Deleting a Task
To delete some Task from the list do the following:
Switch to the Tasks tab sheet;
Click the icon or the name of the Task you want to be deleted to 

select it;
Click your mouse right button on the Task and select the Delete 

command within the context menu or press the <Del> key on your 
keyboard.

This task will be deleted from the list.

5.5.4. Configuring a Task
While developing a new Task (See chapter “Developing a Task”) 

You should configure it, i.e. to specify when and under what conditions it
should be performed, which program should be started by the Task and 
the way this program should be adjusted, where the report on the Task 
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performance should be saved to and etc. Later if necessary you may 
change the configuration.

While developing some Task after you specified it’s name and the 
type press the OK button to display the Task configuration window.

While changing the configuration of some Task in the list to display 
the Task configuration window do the following:

Switch to the Tasks tab sheet.
Click the icon or the name of the Task you want to be configured to 

select it.
Click your mouse right button on the Task and select the 

Configure… command within the context menu.

Fi
Figure 5.6 The Tasks configuration window

Tasks configuration window contains the following tab sheets: 
Preferences (adjusting the being employed by Task program), 
Scheduler (scheduling the Task) and Report (configuring the Task 
reporting mode).

To switch from one tab sheet to another just click on the desired tab.
The following buttons are located in the Task configuration window 

bottom area: Ok, Cancel and Help. If you press the Ok button all the 
made changes will be saved and the window will be closed. To cancel 
all the made changes and close the window press the Cancel button. If 
You need some help press Help.

5.5.4.1. Preferences Tab Sheet
Within the Preferences tab sheet you may see general information 

about the Task and the Options... button enabling You to configure the 
Task performance.

To configure the Task performance do the following:
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Open the Tasks configuration window and switch to the Preferences
tab sheet.

Press the Options... button to open the window enabling you to 
configure the Task performance.

The window design depends on the Task type you specified.

5.5.4.2. Configuring some AVP Scanner Task
The AVP Scanner Task options window contains the following tab 

sheets: Location, Objects, Actions, Settings and Warnings.
The Location, Objects, Actions and Settings tab sheets are similar to 

those of AVP Scanner (For more Information see chapter “Running AVP
Scanner”, subchapter “The Tabs”).

Figure 5.7 The AVP Scanner Task Options configuration window
You should know that for each AVP Scanner Task You develop You 

may specify different groups of settings and these groups will not violate
each other and the settings of AVP Scanner.

5.5.4.3. Warnings Tab Sheet
The Warnings tab sheet contains a list of the diagnostic messages 

that may be submitted to a network administrator to inform him (her) 
about some alarm condition for example on some virus detected in Your
system. Each of the messages may be enabled or disabled.
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To disable a message to be submitted to your network administrator 
click the icon or the name of the enabled message. The icon of the 
disabled message similar to the one displayed above (the switched off 
bulb).

To disable a message to be submitted to your network administrator 
click the icon or the name of the disabled message. The icon of the 
enabled message similar to the one displayed above (the switched on 
bulb).

Generally a network administrator is the person supervising the 
configuration of the messages to be submitted to him (her). Therefore 
these settings are not the subject to a change without his (her) direct 
order.

5.5.4.4. Configuring some AVP Monitor Task
The AVP Monitor Task options window contains the three tabs 

(Objects, Actions and Options) similar to those of AVP Monitor and 
the Warnings tab.

Figure 5.8 The AVP Monitor Task Options configuration window
For each AVP Monitor Task You develop You may specify different 

groups of settings.
When some AVP Monitor Task is started AVPCC automatically 

terminates the previous one (You have it). In this case AVP Monitor will 
not be unloaded to restarted the new one but AVPCC will just renew the
AVP Monitor settings.

After the AVP Monitor Task performance will be finished the previous
AVP Monitor Task (and the corresponding AVP Monitor settings) 
performance will not be restored even if the time period of this Task will 
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not be expired. The only AVP Monitor Task the performance of which 
being restored each time the Recurring AVP Monitor Task is finished is 
the one that starts when You start Windows and finishes when You shut
down or restart Your computer. So each time the scheduled by You 
AVP Monitor Task performance will be finished the AVP Monitor current 
settings will be replaces with the ones of the AVP Monitor Continuous 
Task.

The Warnings tab sheet was described above in the chapter related 
to configuration of some AVP Scanner Task. The only difference You 
may notice here is the messages that may be submitted to a network 
administrator.

5.5.4.5. Configuration the Other Task
Since AVPCC just like any other task planner doesn’t now where and

how an “external” program stores its settings the only way for AVPCC to
configure the Other Task is to specify the program settings in a 
command line. So all the AVPCC Other Task settings located within 
three the following tab sheets: Main, Settings and Warnings.

The Warnings tab sheet is similar to those described above.
The Main Tab Sheet 
The tab sheet contains two text fields. If You want to employ some 

“external” program (meaning the program that doesn’t correspond to the
AVP package component) specify the program executable file full-path 
name in the Program Name text field.

If You want to find some file in Your computer press the Browse… 
button to select the desired file in the folder/file tree dialog box or if You 
know the full-path name of the desired file just type it in.

The switches and other command line parameters of the program 
You want to be scheduled by AVPCC should be specified in the 
Command Line text field. To learn about these switches and other 
parameters refer to the manual of the program You want to be started 
by AVPCC.
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Figure 5.9 The Other Task Options configuration window
The Settings Tab Sheet
The Settings tab sheet enables a user to adjust the AVPCC Other 

Task reporting mode.
To enable the Report option check the Report file: check box. When

the box is checked the below text field becomes available for You to 
specify the name of the file You want the AVPCC Other Task reports to 
be stored in. 

Figure 5.10 Configuring the report
The Append check box if checked enables AVPCC each time the 

Other Task performance is finished to add the developed report to the 
report file contents.
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It’s very useful since any time you want you will be able to review 
reports on several or all the previous Other Task performances. If the 
Append box is checked do not forget to check the Limit size: check box
to limit the report file size (The value (Kb) can be entered in the below 
text field.) for the file not to occupy too much space (When the file size 
will match the specified value the report file contents will be totally 
renewed).

5.5.5. Scheduler Tab Sheet
This tab sheet within the Tasks configuration window enables a user 

to schedule a Task performance. The following starting modes may be 
specified for each Task (The AVP Monitor Task is the exception) Your 
want to be performed:

 by event (It means that the Task performance will be started 
upon some even appointed by a user);

 by condition (it means that Task if some action will exit with 
definite code)

 hourly
 daily;
 weekly;
 monthly.
To enable a mode you should check the corresponding option 

button.
After the choice is made the following scheduling elements will 

appear within the sheet right-side area:
 (by event) a drop down list of the events, or
 (by condition) or 
 (hourly) or
 (daily) the Time box for You to appoint the time of the day You want 

the Task performance to be started, or
 (weekly) the Time box and the weekdays check boxes list for You to

appoint the time of the day and the day of a week You want the 
Task performance to be started, or

 (monthly) the Time box and the monthly schedule menu for You to 
appoint the time of the day and the day of a month You want the 
Task performance to be started.

Let’s review several examples.
To schedule a Task to be started manually do the following:
Check the By Event check box;
In the event drop down list select Manually Upon User Request.
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Figure 5.11 Scheduling the Manual start
To schedule a Task to be started daily:
1. Check the Daily check box;
2. Click your mouse right button within the Time box and select 

Add... in the context menu to open a box.
3. In the box specify the desired time.
4. Press the ОК to add the above icon and the time to the Time 

box.

Figure 5.12 Scheduling a Task to be started daily 
To schedule a Task to be started more than once a day you should 

specify in the Time box time for each start.
To change some Task startup time do the following:
Click your mouse right button on the Task startup time icon and 

select Change... in the context menu to open a box.
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In the box specify the desired startup time and press ОК.

Figure 5.13 Scheduling a Task to be started weekly
To delete some startup time from the Time box click Your mouse 

right button on the startup time icon You want to be deleted and select 
Delete in the context menu. 

Figure 5.14 Scheduling a Task to be started weekly
While scheduling the AVP Monitor Task the Scheduler slightly differs

from the described above one. There are two the following modes within
the AVP Monitor Task Scheduler tab sheet:

Continuous;
Recurring.
To enable one if the modes You should click the corresponding 

option button.
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If You enabled the Recurring option button the From and To 
options, related to the time period during which You want the Task to be
performed, should be specified.

To specify the time period for the AVP Monitor Task to be performed:
Press the Settings... button corresponding to the From: text field to 

open the window similar to the other Task types Scheduler tab sheet 
(described above).

In the window specify the startup time and the periodicity, or select 
the event for the AVP Monitor Task to be scheduled to start upon.

To specify the time for the AVP Monitor Task performance to be 
finished repeat steps 1 and 2 for the To text field.

Figure 5.15 Scheduling the AVP Monitor Recurring Task

5.5.6. Report Tab Sheet
Report tab sheet enables a user to be reported on a Task that was 

performed. The tab sheet is separated in two frames. In the right frame 
You may review the contents of the file the name of which was specified
in the Report file text field in tab sheet according to task you want to be 
reviewed (For AVP Scanner Task – Options Tab sheet; for the AVP 
Monitor Task – the Options tab sheet; for the Other Task – Settings tab 
sheet). The frame size may be changed according to your requirements.
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Figure 5.16 Checking the report file contents
5.5.7. Starting Tasks Manually

If while configuring a Task You checked the By Event check box and
appointed Manually Upon User Request in the event drop down list to 
perform this Task You should start it manually. To start a Task manually
do the following actions:

Switch to the Tasks tab sheet;
Click the icon or the name of the Task You want to be started;
Click Your mouse right button on the selected Task and select Start 

in the context menu.

5.5.8. Reviewing a Task Performance Results
To review some Task performance results You should switch to the 

AVPCC main window Report tab sheet. The sheet is similar to the 
Report tab sheet of the Task configuration window. The only difference 
is that in the AVPCC main window Report tab sheet the list of all the 
developed by You Tasks being displayed.

To review the results of some Task performance double-click the 
icon or the name of the Task in the list.
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6. Running AVP Updates
The AntiViral Toolkit Pro software package AVP Updates utility 

enables a user to automatically update the AVP current databases, 
containing information on viruses, and the units.

You may update Your AVP through the Internet using network 
connection or the Dial-Up one. The version and the databases also may
be updated by means of your local network.

To install the AVP Updates utility onto your computer You must 
check the corresponding check box of the AVP installation program (For
more information see chapter 4.1).

6.1. Starting AVP Updates
To start AVP Updates:
1. Press the Start button (Windows 95/98/NT Workstation).
2. Point to Programs.
3. Point to the AVP group.
4. Point to AVP Updates.

The utility interface introduces one by one several windows, to move 
between the windows use the Next and Back buttons.

Right after AVP Updates started the Settings window will appear on 
Your screen. The window enables a user to adjust the utility, ones the 
settings are made they will be saved by AVP Updates and when started 
next time the utility will be set the same way.



Figure 6.17 The Settings window
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6.1.1. Updating through the Internet
To Update through the Internet a user may employ network 

connection or the Dial-Up one. If the Dial-Up connection already 
configured on Your computer AVP Updates will use these settings, so 
You do not have to waste Your time and make the settings again.

To adjust AVP Updates you just have to specify the Web site 
address for the utility to automatically download the AVP updates from. 
Besides to enter the Web site updates area a user should specify his 
(her) AVP login name and the password.

The adjust AVP Updates make the following steps:
Enable the Internet option button.
Press the Setup button to open the Internet settings box.
In the URL text field specify the AVP site address for AVP Updates 

to download the updates from (Example: ftp://ftp.avp.ru/updates).
Note:
Your AVP site address is specified in Your AntiViral Toolkit Pro set 

documentation. To learn the address You also may contact Kaspersky 
Lab. If You subscribe the AVP annual subscription package You will be 
informed on the address to download the updates from.

In the User text field specify your login. Your password should 
specified in the Password field. (To obtain your login and password you 
should subscribe for the AVP updates).

Figure 6.18 The Internet settings box
If You use a proxy server to access the Internet You can adjust AVP 

Updates to correctly cooperate with Your server. To do it:
Enable the Internet settings box Use proxy server check box.
Specify Your proxy server address in the HTTP text field.
Specify the port number being used to access the Internet in the Port

text field (The default number is 80). (For information about Your proxy 
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server address and the port number refer to Your network administrator 
or the Internet provider.)

To finish the adjustment press Ok.

6.1.2. Updating through Your Local Network 
If You administer a large corporation local network You may save the

Internet time and traffic and therefore money by establishing a system 
for all the network users to update their AVP packages through the 
network. To do it You just have to regularly download the AVP updates 
through the Internet to some folder established for the AVP updates on 
one of Your network computers (for example the network file server). To
automatically update AVP from this folder the network user should 
adjust the AVP Updates the appropriate way.

To adjust the AVP Updates to be able to download the updates from 
a local network a user should:

Enable the AVP Updates window Network storage option button.
Press the Browse button to open the Open dialog box.
Find Your AVP updates network folder in the box and press Ok to 

specify the full-path folder in the Network storage text field.
For information about Your AVP updates network storage location 

refer to Your network administrator.

6.2. Customizing the AVP Updates Report File
When the AVP Updates channel is specified press the Next button to

open the AVP Updates second window.
In this window you may enable/disable AVP Updates to report on the

update operations.
To enable the Report option check the Report file: check box. When

the box is checked the below text field becomes available for You to 
specify the name of the file You want the AVP Updates reports to be 
stored in. 
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Figure 6.19 The AVP Updates Report window
Append check box if checked enables AVP Updates each time the 

update operation is finished to add the developed report to the report file
contents. It’s very useful since any time You want You will be able to 
review reports on several or all the previous update operations. If the 
Append box is checked do not forget to check the Limit size: check box 
to limit the report file size (The value (Kb) can be entered in the below 
text field.) for the file not to occupy too much space (When the file size 
will match the specified value the report file contents will be totally 
renewed). 

6.3. Downloading the Updates
After AVP Updates is adjusted You may press the Next button and 

move to the next window enabling You to download the updates.
In the first AVP Updates window check the Antivirus bases check 

box if You want the up-to-date antivirus databases to be downloaded 
onto Your PC, or the Patches check box if You want to update Your 
AVP components or both the check boxes to update both the databases
and the components.

Press the Next button to start the updating operation:.
The Retrieving updates window reflecting the operation in progress 

will appear on Your screen. 
The four stages of the AVP updating operation are:
Connecting to the server;
Downloading files;
Installing files;
Disconnecting.
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When a stage will begin the  mark to the left of the stage will be 

replaced with the  mark meaning that this stage is in progress and 
the stage status information will be displayed in the corresponding field. 

The  mark to the left of the stage means that this stage is 
successfully completed.

Figure 6.20 The Retrieving updates window when the updating
operation is in progress

After all the updating operation stages will be successfully completed
the corresponding AVP Updates window will appear on Your screen.

Figure 6.21 The Updating operation is successfully completed
To quite the AVP Updates utility press the Ready button.
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7. Appendix. Kaspersky Lab Ltd.

Kaspersky Lab
Kaspersky Lab Ltd. is a fast growing international privately owned

software development company with offices in Moscow (Russia) and
Cambridge (UK). Having started the business in 1992 Kaspersky Lab
concentrates  its  efforts  on  the  development,  marketing  and
distribution  of  world-leading  anti-virus  technologies  and  computer
software.

Industry-leading anti-virus technologies
Kaspersky Lab. is commonly known company that produces antiviral

products. AVP uses the industry’s leading anti-virus technologies. Many
technologies now used by other anti-virus products were first developed
in AVP:
1992 – the first to use pseudo-codes in the anti-virus database
1992 – the world’s first processor emulator for code decryption
1992 – the first external anti-virus database with embedded specialized

modules
1993 – the first product to search within archived and compressed files
1994 – the first to use new principles of heuristic code analysis
1997 – the fastest library for macro-virus processing
1998 – the world’s first memory-resident real-time virus interceptor for

OS/2
1999  –  the  world’s  first  integrated  anti-virus  protection  for  Microsoft

Office 2000
1999 – the world’s first anti-virus with deep integration into NDS (Novell

Directory Service)

Extremely high level of virus detection and removal
During the last 5 years AVP has been permanently among the three

best anti-virus products in the world. In tests carried out by computer
magazines around the world, AVP is consistently named as  the most
reliable anti-virus software they have ever seen.
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Boot File Macro- Polymorphic Standard

Kaspersky Lab AVP 100.0 100.0 100.0 100.0% 100.0%

NAI McAfee VirusScan 100.0 99.9% 99.9% 100.0% 100.0%

Symantec Norton 97.3% 100.0 99.4% 93.9% 99.7%

CA InnoculateIT 100.0 100.0 99.7% 96.9% 99.9%

Norman Virus Control 100.0 100.0 99.8% 96.9% 100.0%

Command AntiVirus 100,0 99,4% 99,8% 98,0% 100,0%

Sophos Anti-Virus 100.0 97.9% 98.2% 96.9% 99.5%

Source: Virus Bulletin (UK), September, 1999

Proof of AVP’s high quality is provided by certificates from the 
International Computer Security Association (ICSA) and West Coast 
Labs (CheckMark)

For the full comparative test of anti-virus software see 
http://www.virusbtn.com/100/vb100sum.html

Highly effective heuristic code analyzer
AVP’s  new heuristic  algorithm is  able  to  detect  92% of  unknown

viruses. At the same time the number of false alarms is very low.
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Product False Alarms

Kaspersky Lab AVP 0

DialogueScience Dr.Web 18

Command AntiVirus 1

Proland Protector Plus 89

Frisk F-Prot 1

Source: Virus Bulletin (UK), May, 1999

Safe and dependable operation on infected computers 
AVP neutralizes viruses in virtual sessions. It correctly removes MBR

and boot viruses from hard and floppy disks. It removes viruses from
files locked by another process. It can detect and remove viruses from
itself.

Support for most popular e-mail encoding formats
Today, e-mail is one of the main channels used by viruses to spread.

Control  over  e-mail  traffic  is  an  essential  part  of  effective  virus
protection. AVP has built-in support for detecting viruses inside e-mail
messages  that  are  stored  in  the  most  popular  formats:  Outlook,
Microsoft  Mail,  Microsoft  Internet  Mail,  Netscape  Navigator  Mail,
Eudora,  Pegasus  Mail,  UUEncode,  XXEncode,  Btoa,  BinHex,  Ship,
NETRUN,  NETSEND,  MIME  base64,  JSMail  SMTP/POP3  server.
There’s no need to buy another anti-virus product especially for e-mail.

Virus detection and removal in compressed and 
archived files

Archives are commonly used to package files for distribution by e-
mail  or  download from the Internet.  Some anti-virus products do not
check for viruses inside compressed and archived files. AVP was  the
world’s  first anti-virus  to  do  so.  It  can  check  more  different  archive
formats than any other product, including ZIP, ARJ, LHA, RAR, TAR,
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GZIP,  PKLITE,  LZEXE,  DIET,  COM2EXE,  COM2COM,  EXEPACK,
PGMPACK, UCEXE, WWPACK, WWPACK32, ASPACK etc., and this
list is constantly being extended.

Weekly anti-virus database updates
Every week up to 200 new viruses appear. Your system is at risk

from new viruses until  your anti-virus database is updated to include
them. AVP’s database is updated weekly, so AVP provides unbeatable
protection.  You may update your antiviral  databases via Internet  and
BBS

Immediate response to new virus attack
When new types of virus appear, exploiting new operating system 

features or security loopholes, AVP, using the most advanced 
technologies, will neutralize it fastest. In June, 1998 Kaspersky Lab took
just 3 hours to develop the world’s first effective cure module for the 
Win95.CIH (“Chernobyl”) virus.

Personal attention to every client
When a registered user reports an unknown virus, Kaspersky Lab

will develop a personal cure module within 48 hours. This module will be
provided directly to all customers in the next weekly update.

Information support
Kaspersky  Lab  produces  AVP  Virus  Encyclopedia

(http://www.viruslist.com)  –  a  unique  resource  containing  information
about more than 15,000 viruses available to all AVP users.

The newsletter “Kaspersky Reports..” is published every two weeks, 
containing extensive information about the most interesting and 
dangerous viruses that have appeared in that time.

When a new extremely dangerous virus appears, Kaspersky Lab 
sends you a personal notification which includes a description of the 
virus and how to prevent it.
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Integrated network solution for the whole enterprise
The  AVP  product  family  comprises  a  complete  set  of  tools  that

provide virus protection for both workstations and network servers, and
the means to control it. AVP is a  comprehensive integrated system of
anti-virus protection:
 For all  corporate network components: workstations, servers, mail

systems, firewalls;
 For most popular operating systems;
 Includes powerful and flexible management tools

Year 2000 compliant
Kaspersky  Lab is  the  first  anti-virus  software vendor  to  certify  its

products for year 2000 compliance in an independent testing lab. This
certificate confirms that all AVP family products will work correctly after
year 2000.

Certificates
AVP for Windows is certified by Microsoft’s Testing Lab and carries 

the “Designed for Windows 95/NT” and “Designed for Windows 98/NT” 
logos.

AVP is checked for 100% detection of viruses “In-the-Wild” by 
leading anti-virus testing lab - West Coast Labs. AVP has the 
“CheckMark” certificate.

AVP is certified by the International Computer Security Association 
(ICSA).

AVP is certified by state committee for the year 2000 compliance. 
The certificate corresponds with VTU 115-006-1999 standard, which is 
similar to DISC PD2000-1 standard of the British Standard Institute.

Other Kaspersky’s Lab AntiViral Products
All the AVP software products use the same antivirus bases 

(updates) what is very convenient especially for users applying AVP 
under several platforms.

AntiViral Toolkit Pro for Windows 95/98/NT Workstation
AVP for Windows 95/98/NT Workstation is a completely 32-bit 

application that corresponds to a powerful integrated antivirus system 
comprising AVP Scanner and resident AVP Monitor. The AVP for 
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Windows 95/98/NT built-in AVP Updates engine enables a user to 
automatically update the antivirus bases via the Internet or from network
storage. There are several editions of the product: AVP Platinum 
edition, AVP Gold edition, AVP Silver edition and AVP Lite edition.

AntiViral Toolkit Pro for DOS
AVP for DOS 32 (AVPDOS32) is a 32-bit application specially 

developed for the DOS 32 environment. The package contains an 
antivirus scanner and the setting program. Both the components are 
armed with interfaces appropriate for the environment.

AntiViral Toolkit Pro for Novell NetWare
AVP for Novell NetWare (AVPN) is an antivirus system for the 

Novell NetWare computer network. AVPN performs scanner and filter 
tasks permanently supervising server files.

AntiViral Toolkit Pro for Windows NT Server
AVP for Windows NT Server is designed to build a reliable antivirus

protection system on the file and application servers operating under 
Microsoft Windows NT Server.

AntiViral Toolkit Pro for OS/2
AVP for OS/2 is a 32-bit application specially designed to operate in 

the IBM OS/2 environment. This package scanner and monitor are the 
first antivirus tools in the world armed with the OS/2 Presentation 
Manager user interface.

AntiViral Toolkit Pro for Linux
AVP for Linux is a 32-bit application specially designed for the Intel 

platform UNIX environment. The package is armed with an antivirus 
scanner similar to the one of AVP for DOS 32.

AntiViral Toolkit Pro Inspector
AVP Inspector enables a user to protect workstations operating in 

the Windows environment from viruses. Inspector checks files, folders 
and disk sectors for any modification that corresponds to a virus 
manifestation.
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AntiViral Toolkit Pro WEB Inspector
AVP Inspector for WEB Servers is a supplementary utility designed

to protect Web server contents from any unauthorized modification. This
product is an ideal tool enabling a user to monitor Web servers.

AntiViral Toolkit Pro Control Center (AVPCC)
AVP Control Center enables a user to control all the other 

components of the AVP package. AVPCC provides the ability to adjust 
and schedule AVP virus checking units automatic starts and the bases 
updates. This AVP integrated shell utility operates under Microsoft 
Windows 95, Windows 98 and Windows NT.

AntiViral Toolkit Pro Network Control Center (AVPNCC)
AVP Network Control Center enables a network administrator to 

control AVP components (to install and update the components, to 
schedule AVP units automatic start, to adjust their reporting mode and 
etc.) on any remote workstation of the network.

AntiViral Toolkit Pro Virus Encyclopedia (AVPVE)
AVP Virus Encyclopedia is an electronic HTML document. AVPVE 

details on almost all the worldwide ever detected viruses (more than 
5000 pieces), their classifications, detection and deletion approaches, 
their operation concepts, their manifestations and after-effects of the 
virus infection. The product also demonstrates graphical and sound 
effects produced by viruses. AVPVE is FREE! It may be downloaded 
through the Internet at the following addresses: http://www.avpve.ru or 
http://www.viruslist.com.

Kaspersky Lab Contact Information
If you have any questions, comments or suggestions you may refer 

to our distributors listed in your AVP README.TXT file or directly to 
Kaspersky Lab. We will be glad to consult you on any matters related to 
our product by phone or e-mail and all your recommendations and 
suggestions will be thoroughly reviewed and considered.

Our contact information:
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Address
:

: 10, Geroyev Panfilovtcev Street, 123363, Moscow, 
Russia, Kasperskly Lab

Phone: : +7 (095) 948-43-31 - Sales Department,
+7 (095) 495-03-00 Technical Support
+7(095)948-56-50 Marketing and Advertising 

Department
Fax: : +7 (095) 948-4331
BBS: : +7 (095) 948-6333, +7 (095) 948-3601 (clock round 

service)
E-Mail: : globalsale@avp.ru – distribution related matters

support@avp.ru Technical Support
newvirus@avp.ru - Antiviral Laboratory (information 

about viruses only)
info@avp.ru - Marketing and Advertising Department

FidoNet
:

: 2:5020/156;

WWW: : http://www.avp.ru, http://www.viruslist.ru
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